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Price Checker Setup Guide for AIMsi 
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Configuring the Price Checker Shuttle 

 
The Price Checker comes with a configuration program used to configure each shuttle.  
 
1. Insert the Shuttle SG-15 Product Support CD in the CD drive. 
 
 

 
 
 
2. The screen above opens. Double click on the Configuration Tool folder. 
 
 

 
 
 
3. Double click on SG15Config.exe. 
 
 

 
 
 
4. The Shuttle SC15 screen above will open.  
5. Connect the Price Checker hardware to the PC network via a standard network cable. For 

help, contact your IT Administrator. 
6. Press the Scan button on the Price Checker software screen above in the yellow box to 

locate the device. The software may take 1 – 2 minutes to locate your device. 
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7. Select the device in the list on the right and press the Configure button. If the device does 

not appear then the hardware is not connected correctly. It must be connected to continue 
with these instructions. Please contact your network administrator for help. 

 
Note:  If you are having trouble connecting to the device, please verify the default IP Address as 
listed in the device documentation. Some wireless devices default to a 192.168.3.xxx network. 
 
 

 
 
 
8. On the Network tab under IP Settings: 

A. Assign a unique IP Address to the Price Checker device. For an available IP Address, 
please consult your IT Administrator. 

B. Set the Subnet Mask of your local area network. Default value:  255.255.255.0. 
C. Set the Default Gateway of your local area network. Default value:  192.168.0.1. 

9. Under Connect Mode: 
A. Select TCP. 
B. Select Client. 
C. Set Connect To Port. This can be any unused port number that the shuttle will use to 

connect to the PriceChecker server and must match the server port setting in the 
PriceChecker software program.  

D. Set the Remote IP address to the IP address of computer running the PriceChecker 
server software. To find your computer’s IP Address see 
http://www.ehow.com/how_2091470_computer-ip-address-windows.html.  

10. After making changes click on the Apply Now button. Other items can be set with the 
configuration software such as messages that are displayed by the shuttle, rotation of the 
messages, and other options. Please see the user’s manual that accompanies the shuttle. 

http://www.ehow.com/how_2091470_computer-ip-address-windows.html
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11. Repeat the above steps as needed to configure multiple Price Checker units. The Checker 
software can connect to multiple devices. 

 
Note:  If DHCP is used to assign the IP address to the SG-15, use the SG15 config.exe to obtain 
the shuttle’s IP address. The address is displayed in the upper left corner of the screen. Also note 
that with the DHCP selected, the IP address may change. Please consult your IT Administrator 
for more information. 
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Configuring the Wireless SG15+ Price Checker Shuttle 

 

Tri-Technical Systems offers two SG-15 devices. One device only supports wired LAN 
connections and the other can support both wired and wireless connections. Below are sample 
wireless screens. On the wireless terminals a jumper must be set to activate the wireless option.  
 

Wireless Example – Network Tab 
 

 

 
 

Wireless Example – Wireless Tab 
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Wireless Example – Messages Tab 
 
 

 
 
 

Wireless Example – Miscellaneous Tab 
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Wired Example – Network Tab 
 
 

 
 
 
Note:  Contact your IT Administrator for this information as well as the other settings on this page. 
 
 

Wired Example – Wireless Tab  
 
Note: The Wireless Tab is not applicable for the wired option. 
 
 

Wired Example – Messages Tab 
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Wired Example – Miscellaneous Tab 
 
 

 
 
 
On the Miscellaneous tab, a Codepage of 0866 (Cyrillic II) or UTF-8 Unicode is recommended. 
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PriceChecker Software Setup 

 
1. After installing Tri-Technical System’s Price Checker software, open the PriceChecker.exe. 

Call Tri-Technical Systems at 800-670-1736 for a release code to activate the software. The 
default location will be C:\TTS\PriceChecker. 

 
 

 
 
 
2. A PriceChecker shortcut icon will be placed on the desktop. Open the software by double 

clicking the icon. A screen will open saying that the release code entered is not valid. Click 
OK. 

 
 

 
 
 
3. Enter the Release Code on the Price Checker Release Code screen in the Release Code 

entry box. Click the Update Release Code button. For more information on the release code 
screen, see Activation. 
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AIMsi Setup 

 
If using an external database skip this section and proceed to the Price/Ticket Option section. 
 
Note:  To Interface with AIMsi Version 9.0, users will need the 1/18/2011 update or newer. AIMsi 
Version 10 is also supported by the Price Checker software. 
 
1. The ad.dll file must be placed in the same location as AIMsi.exe and have a date of 

9/30/2010 or newer.  
2. AIMsi users will need to copy and register ad.dll. This file will be installed to 

C:\TTS\PriceChecker\ with the Price Checker installation.  
3. Copy it to the folder containing your Aimsi.exe file. (Default location is C:\AIMsi) 
4. Click the Start menu and select Run.  
5. Type in cmd and click OK. This will bring up a command prompt window on most operating 

systems.  
6. Type in the following command:  regsvr32 ‘FullPathToAimsi\ad.dll’ then hit the Enter key. Be 

sure to substitute the FullPathToAIMsi with the actual full path to the location of AIMsi.exe. 
For example, ‘C:\Programs\AIMsi\ad.dll’.  

 
Note:  On Vista®, Windows 7®, and Windows 8 systems, UAC may need to be disabled or status 
lowered before registering your ad.dll. Reactivate UAC after the process is completed if desired. 
 
7. If needed, reopen the Price Checker software. 
 
 

 
 
 
8. Scroll down from the Tools menu to Preferences. 
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9. On the Server tab: 

A. Click on Select Price From AIMsi to select it. 
 
 

 
 
 

B. The Server IP Address is the IP address of the current PC. 
 
 

 
 
 

C. Set the Server Port to the server port assigned to the SG-15 shuttle. 
 
 

       
 
 

D. The Print and Export font can be changed by clicking on the Select Font button. The 
Font screen will open. Select the Font, Font Style, Size, Effects, Color, and Script. Click 
OK to close the Font screen. 
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10. On the AIMsi tab, enter the path to the AIMsi.exe file. 
 
 

 
 
 
11. On the Price Checker tab, click the Add Unit button. 
 
 

 
 
 
12. Add the following information: 

A. Unit Location is a descriptive name to indicate where the unit is located. This name is 
displayed in reports with the scan codes of items that are not found. 

B. IP Address is the IP address assigned to the shuttle. 
C. AIMsi Location Code is the location within AIMsi used for price lookups. 
D. Location Name is the name of the store within AIMsi. 

13. Click OK when complete. 
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14. Add information for each shuttle. As information is added for each shuttle, it is displayed in 

the grid on the Price Checker tab. 
15. Test the IP connection of each shuttle by clicking on the shuttle in the grid, then click on the 

Ping Selected Unit button near the bottom of the screen. 
16. If the setup is correct, an Information screen will open letting the user know the setup is 

correct since a reply was received from the unit. Click OK to close the Information screen. 
The name on the Ping Selected Unit button will change to Pinging Unit as it communicates 
with the unit. 

 
 

 
 
 
17. If the setup is not correct, the connection will timeout. An information screen with 

“Connection Timeout” will open. Click OK. Check the setup and try again. 
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18. To edit a unit once it has been added, click on the unit in the grid to highlight it. Click the Edit 
Unit button. 

 
 

 
 
 
19. The Add Unit screen will open. Make the desired changes then click OK to post the changes 

or Cancel to close the screen without making changes. 
 
Select Price From AIMsi option 
 
 

      
 
 

 
 
 
Depending on the option picked on the Server tab, column headers on the Price Checker tab will 
change as well as the items to enter on the Add Unit screen. The Select Price From AIMsi 
option includes Unit Location, IP Address, AIMsi Code, and Location Name. These items 
appear as the column headings of the grid on the Preference screen shown above. 
 
20. Now proceed to the Running the program section. 
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Running the program 

 

 
 
 
1. After setting up the Preferences, start the PriceChecker server by clicking on the Start 

Server button. 
 
 

 
 
 
2. As the shuttle units start connecting to the PriceChecker, server information will be displayed 

in the Connection List. The Start Server button now says Server Active. 
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3. As items are scanned, information will be displayed on the left side of the program. 
 

Print 

 

 
 
 
1. Scanned item reports can be printed and exported by selecting File from the top menu. To 

print the reports select Print from the drop down menu. 
 
 

 
 
 
2. A Select screen will open. Pick from the list the items to print. Click the OK button. The item 

list is sent to the default Windows® printer. 
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Price Checker All Items Report 
 

 
 
 
3. Selecting Print All Items will print all items on the left side of the screen in Step 3, including 

duplicates in the report. 
 
Price Checker Unique Items Report 
 

 
 
 
4. Selecting Print Unique Items Only will print only unique items found. 
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Price Checker Items Not Found Report 
 

 
 
 
5. Selecting Print Items Not Found will only print items not found on the screen in Step 3. 
 
PC Unique Items Not Found Report 
 

 
 
 
6. Selecting Print Unique Not Found Items will only print unique and not found items from 

Step 3. 

 
 

Export 

 

 
 
 
1. To export the items, select Export from the File menu. Select a file location to use to save 

the exported data. 
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2. Pick the items to export and click OK. 
3. To exit the program select Exit from the File menu or from the Exit button at the bottom right 

of the screen. 

 

Exit 

 

 
 
 
1. The program can be exited from the main screen. From the top menu under File, scroll down 

to Exit. 
 
 

 
 
 
2. The program can also be exited by clicking on the Exit button on the main screen. 

 

Clear Display 

 

 
 
 
1. To clear the data from the left side of the main screen, go to the top menu. 
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2. Under Tools, scroll down to Clear Display. The Clear Display only clears the data from the 

left side of the screen. It does not remove the Connection List on the right. 
 

Preferences – Print Font 

 

 
 
 
1. To change the print font, go to the Tools menu, scroll down to Preferences. 
 
 

 
 
 
2. On the Server tab  
 

A. Select the Font, Font Style, Size, Effects, Color, and Script. Click OK to close the Font 
screen. 
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A. Change the font on the Print and Export display by clicking the Select Font button. A 
Font screen will open allowing the user to select the Font, Font Style, Size, Effects, 
Color, or Script. Click OK to close the Font screen. 

 

Activation 

 

 
 
 
1. The Price Checker Release Code screen is found by scrolling down to Activation on the 

Tools menu at the top of the screen. 

 
 

 
 
 
The Release Code determines the software’s Date Range of functioning, the Serial Number, and 
the Number of Units that are allowed. Note:  The Release Code updates this information 
automatically; it cannot be edited. 
 
2. After installation, the software whether installed from a CD or from the Tri-Technical Systems 

web site at www.technology4retailers.com, will require a Release Code to open the software. 
After installation, the software whether installed from a CD or from the Tri-Technical Systems 

http://www.technology4retailers.com/
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web site Please email Tri-Technical Systems at sales@technology4retails.com for the most 
efficient way of obtaining the new Release Code. If email is not available, call 563-556-3556.  

3. After entering the Release Code given by Tri-Technical Systems staff, click the button labeled 
Update Release Code. The Release code MUST be entered during the date range it is given 
for or it will not work! Check the dates displayed in the boxes shown under Expiration Date to 
make sure the date range is correct. 

4. The Close button closes the release code screen. 

 
Please Note:  The Get Cancellation Code button cancels the software on the computer. You will 
not be able to open it after this is pressed. If the software is to be moved from one computer to 
another, you will be required to use the Get Cancellation Code button. Contact your cash 
register dealer before moving the software. 

 

Help 

 

 
 
 
1. To find the version of the Price Checker software, click on Help on the top menu and scroll 

down to About. 
 
 

 
 
 
2. The software version number will be displayed. Click on OK to close the screen. 
 
 

mailto:sales@technology4retails.com

